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INTRODUCTION

WdsPick has been developed as an help to the astronomer making measurements of double stars.  
WdsPick offers two complementary functions. First, a filter-based mechanism for building lists of 
target stars from the Washington Double Star Catalog [1] and navigating through these lists. 
Second, a connection to the well-known SkyChart [2] application for automatically visualizing 
star positions and pointing telescopes.  This is illustrated in Fig. 1, showing both the WdsPick and 
SkyChart applications side by side (left and right respectively). Here WdsPick is navigating 
through a list of 98 target stars. The current selection is BU 1216, whose main elements are shown 
(including ephemerides computed from the Sixth Catalog of Orbits of Visual Binary Stars [2]).  A 
connection has been established with the SkyChart application and the latter has been instructed 
to point to the corresponding position. If the SkyChart application is actually controling a 
telescope (by means of an ASCOM interface, for example), initiating a physical GOTO would then 
automatically bring the target star in the FOV (or the camera)

Figure 1
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1. INSTALLING

Installation is straightforward : just copy and unzip the archive file wdspick.zip (available on the 
website : www.astrosurf.com/legalet/software/wdspick) on your computer. This creates a directory 
named WdsPick containing all the required files (executables, libraries and configuration files). For 
convenience, the distribution includes text versions  of the WDS and 6th Orbit Catalog. If 
necessary, these files can updated with more recent versions, downloaded from the USNO site.  The 
former is  mandatory (WdsPick is of little use without it..). The latter file can be omitted but, in this 
case, WdsPick will not be able to display ephemeride values for the concerned stars.

 
2. LAUNCHING

Double-clic on the program file wdspick.exe. This opens the window illustrated in Fig. 2. 

Figure 2 - The Extract tab used for building target lists
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The three main components of this window are
- a menu bar with three menus (File, Action and Help) at the top
- two tabs named Extract and Browse respectively
- a status bar showing some informations at the bottom

The Help menu gives access to the About action which prints some information on the program.

The Action menu has only one item, Extract. Invoking this action is equivalent to hitting the 
Extract button located at the bottom of the Extract	  tab, or typing "Ctl-E".

The File menu has three items for loading or saving so-called specification files (see below) or 
quitting the application respectively.

The information shown in the status bar are are, from left to right
- the coordinates of the observatory (longitude and latitude),
- the number of entries read in the WDS and the ORB files,
- the number of entries read in MES file (see below),
- the number of entries read in the ADC file (see below).

Initially, the application shows the Extract tab, whose function is to specify the criteria used for 
building the target list. 

Building a target list

This is achieved by specifying a set of filters in the Extract tab and hitting the Extract button1.

Available filters include
- the equatorial coordinates (RA and Declination),
- the magnitudes of the primary and secondary components (m1 and m2),
- the difference in magnitudes between the two components (dm),
- the separation between components (sep, in arc seconds),
- the year of the last observation, as reported in the WDS (date2),
- the total number of observations, as reported in the WDS (nobs),
- the discoverer code of the star (disc),
- the notes, as recorded in the WDS (notes).

For RA, Dec, m1, m2, dm and sep, a minimal value and/or a maximal value can be specified. Note 
that the specified value is included in the selection, except for the upper bound of RA. For the disc 
and notes criteria, the specified value simply has to occur in the corresponding WDS field. For 
example, for restricting targets to stars discovered by W. Struve, select the Disc criterium and enter 
"STF" in the corresponding text field.  The filter set shown in Fig 2, for example, will select stars
- located between 6h and 7h of RA and 0 and 60° of declination,
- with a primary (resp. secondary) component brighter than or equal to magnitude 10 (resp. 12),
- with a separation between 0.5'' and 1'',
- with no observation reported since 2010
- and having an orbit listed in the 6th Orbit Catalog

1 Or, equivently, invoking the Extract action of the Action menu, or typing "Ctl-E".



The matching entries are extracted from the WDS file (this can take a few seconds) and the 
application automatically switches to the Browse tab. 
The current set of filters can be saved in (resp. loaded from) a file by invoking Save (resp. Open) 
from the File menu (keyboard shortcuts : Ctl-‐S and Ctl-‐O resp.).
Note that it is possible to go back to the Extract tab at any any time to change the filter set and 
build a new target list.

Browsing the target list

Fig. 3 shows the Browse tab obtained with the aforementioned criteria.

Figure 3 - The Browse tab used for navigating through  target lists



The different items are grouped in five categories: Time, Selection, ADC, CdcConnection and Log.

Time group

Here WdsPick displays the current date, UTC time and local sidereal time (LST). The latter is 
correct only if the local coordinates of the observatory have been provided in the wdspick.ini file. 
The local sidereal time is used to compute the horizontal coordinates of the target stars (azimuth 
and altitude, displayed in the ADC group)

Selection group

This group gathers the commands to navigate through the target list. The CNT field gives the total 
number of selected entries and the index of the currently selectedelec entry. The other fields display 
the information retrieved from the WDS for this entry. For stars listed in the 6th Orbit Catalog, 
some orbital informations are also given (orbit grade, reference and the predicted separation and 
position angle, computed from the ephemerides given in the catalog and the current date). 

In the text section at the bottom of the group, WdsPick can also display informations related to 
previous measurements of the selected target. This is useful, for example, to avoid re-measuring a 
given star which has been recently successfully measured or, on the contrary,  to suggest a new 
measurement if the previous ones have been noted as dubious or imprecise.  For this, the list of such 
previous measurements can be provided in the so-called MES file. The name of this file is specified 
in the wdspick.ini file. Its format is detailed in Sec. 3. The number of entries currently available is 
the MES file is displayed in the status line of the application after the "Mes:" indication. 

The Next and Prev buttons can be used to navigate freely in the target list.

Once a connection has been established between WdsPick and the SkyChart application (see 
below), the Goto button instructs SkyChart to point to the current selection (as shown in Fig. 1).

ADC group

WdsPick integrates a rudimentary mechanism for simplifying the usage of an atmospheric 
dispersion corrector (ADC) when observing or imaging double stars at high spatial resolution. With 
such a device, the angle between the rotating prisms (which controls the amount of correction) must 
be adjusted according to the altitude (or equivalently the zenithal distance) of the observed star2. If 
the relation between the zenithal distance and the corresponding ADC setting is known (it can be 
established either theoretically or experimentally) and listed in the ADC file (the name of this file is 
also specified in the wdspick.ini), WdsPick will display the corresponding value in the ADC field. 
The availibility of ADC data is signaled in the status bar of the application after the 'Adc:" 
indication. In any case, WdsPick will display the altitude, zenithal distance and azimuth of the 
current selection. The latter (azimuth) can be useful, for instance, in order to prevent crossing the 

2 In fact, the global orientation of the prisms must also be adjusted according to the global coordinates of the 
star, so that the correction operates in a vertical plane. WdsPick does not take this into account, supposing 
either that this is carried out separately or that observations are performed not far from the local meridian 
(which is the case, in practice, in most of cases)



local meridian when pointing star (which, with certain types of telescope mounts can trigger 
unwanted movements). 

Cdc	  Connection group

This group controls the connection between the WdsPick and SkyChart3 applications. Connection 
is established using TCP sockets. Connection is requested by clicking on the Connect button and 
can be closed by clicking on the Disconnect button. The small text field just below displays 
relevant messages issued by the SkyChart application. Note that the SkyChart application can be 
launched before or after WdsPick, the only important point being that it is actually running (and not 
already connected on the specified address/port) when WdsPick initiates the connection. It is 
recommanded to close the connection (by clicking the Disconnect	  button before quitting one of 
the applications).   

Log group

This group controls writing to the observing session log. Entering a comment in the text field and 
hitting the Save button automatically  adds a line to the log file containing the name of the current 
selection (if applicable), the current time and the comment. The name of the log file is 
"<prefix>YY-MM-DD.log", where <prefix> is specified in the wdspick.ini file (default is 
"wdspick_"). This file is always written in the directory containing the WdsPick executable. An 
example of log file is given in Sec. 3.

3. FILES

WdsPick relies on several external files for correct / optimal operation. All of these files are regular 
text files and can be freely viewed and/or edited

The wdspick.ini file

This file is mandatory and  must be located in the directory containing the application executable. It 
contains the main parameters of the application, in the form "<parameter_name> = <value>" (one 
parameter per line). Valid parameters are (with default value if not found in the .ini file)

• wds_file : path to the file containing the WDS catalog (default : wds.txt)
• orb_file : path to the file containing the 6th Orbit catalog (default : orb.txt)
• wds_cat_index : number of the catalog for double stars under SkyChart	  (default : 5)
• cdc_tcp_addr : IP address for connecting to SkyChart (default : 127.0.0.1)
• cdc_tcp_port : port number for connecting to SkyChart (default : 3292)
• mes_file : path to the file containing the previous measurements (default : mesures.txt)
• adc_file : path to the file containing the ADC settings (default : adc.txt)
• log_file_prefix : prefix for naming the log file (cf Sec. "Log Group") (default : _wdspick)
• launch_cdc_on_start : if "yes", WdsPick automatically launches SkyChart when starting 

(default : no)
• cdc_path : path to SkyChart application, when launched from WdsPick (default : C:\Program 

Files\Ciel\skychart.exe)

3 CdC stands for "Cartes du Ciel", the french name of the SkyChart application



• cdc_args : arguments to pass to the SkyChart application, when launched from WdsPick 
(default : none)

• obs_long : longitude of the observatory (floating point format, negative for east) (default : 0.0)
• obs_lat : latitude of the observatory (floating point format, negative for south) (default : 45.0)

File paths can be specified in absolute or relative format. In the latter case, they are relative to the 
directory containing the WdsPick executable.

An example of wdspick.ini file is given in Fig. 4. 

wds_file = wds.txt
orb_file = orb.txt
wds_cat_index = 5
cdc_tcp_addr = 127.0.0.1 
cdc_tcp_port = 3292
mes_file = mesures.csv
log_file_prefix = wdspick_
launch_cdc_on_start = no
cdc_path = C:\Program Files\Ciel\skychart.exe
cdc_args = 
obs_long = -3.0760
obs_lat = 45.7956
adc_file = adc.txt

Figure 4 - An example of wdspick.ini file
The WDS file

This file is mandatory. It is an image of the WDS catalog, in text format. It can be generated by first 
downloading   the catalog from USNO web site (http://ad.usno.navy.mil/wds/Webtextfiles/
wdsnewframe.html) and saving its  contents in text format (select all, copy, paste into text editor). 
For convenience, the distribution includes a copy of the latest catalog (march 2016). 

!! Warning : it is crucial, when manipulating this file, not to alter its formatting (as specified here : 
http://ad.usno.navy.mil/wds/Webtextfiles/wdsweb_format.txt) since WdsPick relies on it to extract 
relevant informations. Be careful, in particular, when using so-called "rich" text editors (such as 
Word) which can silently replace spaces by tabulations...

An excerpt of the WDS file included in the distribution is given in Fig. 5.

...
07598+1341STF1170      1830 2011   52  97 107   2.2   2.4  8.74  9.09 F5        -011-002 -011-002 +14 1801      075945.52+134119.9
07598+0029BAL1128      1893 1999    3  85  86  17.9  17.9  8.7  12.2  A0        +000+005          +00 2150   D  075950.72+002847.5
07598-0311HJ   75      1825 2000    3 270 275  25.0  25.4 11.43 11.4            -001+001                     D  075953.80-025219.4
...

Figure 5 - Excerpt of the file wds.txt included in the distribution

The ORB file

This file is optional, but strongly recommanded. It is an image of the 6th Orbit Catalog, in text 
format. As for the WDS file, it can be generated by first downloading the catalog USNO web site 
(http://ad.usno.navy.mil/wds/orb6/orb6ephem.html) and then saving its  contents in text format 
(select all, copy, paste into text editor). For convenience, the distribution also includes a copy of the 
latest catalog (march 2016). 

An excerpt of the ORB file included in the distribution is given in Fig. 6.



...
00024+1047 A  1249AB         4    Zir2003      69.7   0.208     68.7   0.222     67.8   0.236     67.0   0.250     66.3   0.263                    
00026-0829 A   428           4    Tok2015c    322.5   0.121    317.3   0.115    311.8   0.111    305.7   0.107    299.3   0.104                    
00046+4206 CHR 122Aa,Ab      4    Cve2008a    311.4   0.114    309.2   0.121    307.2   0.127    305.4   0.133    303.8   0.139                    
...

Figure 6 - Excerpt of the file orb.txt included in the distribution

The MES file

This file is optional. It should contain a list of previous observations to be displayed when a star is 
selected in the target list. Observations must be listed one per line, with each line having the form :

ID;DATE;COMMENT
where

• ID is the WDS discoverer+components designation of the star (ex: "ES 2543AC", "A  1248", ...)
• DATE is the date of the observatio, in decimal format (ex: 2015.576)
• COMMENT is any associated comment

An example of MES file is given in Fig. 7. 

...
STF  60AB;2009.022;Mewlon 210
STF  60AE;2009.022;Mewlon 210
STF  73AB;2013.904;C11, imprecise
STF  73AB;2013.918;C11, ok
...

Figure 7 - Excerpt of a measurement file

The ADC file

This file is optional. It should contain a list of zenithal distances and corresponding ADC settings to 
be displayed a star is selected in the target list. Correspondances must be listed one per line, with 
each line having the form :

Z;R
where

• Z is the zenithal distance, ranging from 0 to 90°, by steps of 1°
• R is the corresponding ADC setting (in decimal format).

The LOG file

This file is generated by WdsPick. It is filled whenever the user enters some comments in the text 
field of the Log group and click the Save button.  

An example of LOG file is given in Fig. 8. 



2016-02-05 20-04-18: seeing=4/10 transparency=2/5. Starting..
2016-02-05 20-06-28: HDS 575: no companion viewed
2016-02-05 20-10-38: A  1839: ok +ref
2016-02-05 20-18-26: A  2034: ok +ref
2016-02-05 20-34-31: D     6: ok adc=1.5
2016-02-05 20-39-05: STT  95: ok texp=10ms
...

Figure 8- Example of session log file

AVAILABILITY

WdsPick is available in binary form for Windows and Mac OS X platforms. Source code is 
available on request. 

WdsPick is mailware : if you find it useful, find bugs or have suggestions for improvements, please 
send an email to the author. Any commercial usage of the WdsPick software is STRICTLY 
FORBIDDEN without explicit authorization by the author. You can make copy and distribute 
WdsPick at the MANDATORY CONDITION that the distributed version includes ALL the files of 
the original distribution (as found on the website, including this manual).

KNOWN BUGS
Not (yet) known. Please report !  
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